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Exam A 

QUESTION 1 

You have an Excel workbook that contains two tables named User and Activity. 

You plan to publish the workbook to the Power BI service. 

Users will use Q&A in the Power BI service to perform natural language queries. 

You need to ensure that the users can query the term employee and receive results from the User table. 

What should you do before you publish to Power BI? 
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A. From PowerPivot Settings, modify the Language options 

B. From PowerPivot Settings, modify the Categorization options 

C. From the Power Pivot model, edit the Synonyms 

D. From Workbook Connections, add a connection 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: http://blog.pragmaticworks.com/optimizing-power-bi-qa-with-synonyms-phrasing-using-cloud-modeling 

QUESTION 2 

You open C:\Data\Data.xlsx in Excel. 

When you attempt to publish the file to Microsoft Power BI, you receive the following error message: “We couldn’t publish to Power BI. Make sure your workbook is 

saved as an Excel file (.xlsx or .xlsm) and is not password protected.” 

You need to ensure that you can publish the file to Power BI. 
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What should you do first? 

A. Decrypt the workbook 

B. Copy the file to a network share 

C. Add a digital signature to the workbook 

D. Disable iterative calculation for the workbook 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://docs.microsoft.com/en-us/power-bi/service-publish-from-excel 

QUESTION 3 

DRAG DROP 

You need to create a PivotChart as shown in the exhibit. (Click the Exhibit button.) 

Exhibit:  
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Which field should you use for each area? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all. 
You may need to drag the split bar between panes or scroll to view content.  

NOTE: Each correct selection is worth one point. 

Select and Place: 
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Correct Answer:  

 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 4 

DRAG DROP 

You create the PivotChart shown in the exhibit. (Click the Exhibit button.) 

Exhibit: 

 

In which area is Product and in which area is SalesAmount? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than 

once, or not at all. You may need to drag the split bar between panes or scroll to view content.  

NOTE: Each correct selection is worth one point. 

Select and Place: 

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/


 

Correct Answer:  

 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 5 

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each 

question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series. 

Start of repeated scenario. 
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You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A 
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.) 

Data Sample exhibit: 
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.) 
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The tables in the model contain the following data: 

 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or 
revenue are recorded for that day. Total Hours and Total Revenue column. 

 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always 

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.  
RepairTypes has a list of all the repair types  Dates has a list of dates from 2015 to 2018 

End of repeated scenario. 

When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot generates the following error message: “The relationship cannot be 

created because each column contains duplicate values. Select at least one column that contains only unique values”. 

You need to ensure that you can create a valid relationship between the tables. 

What should you do? 

A. In the Power Pivot model, change the data type for Workshop[ID] to General 

B. In the workbook query for Workshops, add an index column 
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C. In the Power Pivot model, change the Table Behavior setting for Workshops 

D. In the workbook query for Workshops, filter [IsLatest] to equal 1 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx 

QUESTION 6 

DRAG DROP 

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each 
question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series. 
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repeated scenario. 

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A 
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.) 

Data Sample exhibit: 
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.) 
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The tables in the model contain the following data: 

 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or 

revenue are recorded for that day. Total Hours and Total Revenue column. 
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always 

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.  
RepairTypes has a list of all the repair types  Dates has a list of dates from 2015 to 2018 

End of repeated scenario. 

You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit. 

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/


 

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate fields to the correct targets. Each value may be 
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.  

NOTE: Each correct selection is worth one point. 

Select and Place: 
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Correct Answer:  

Section: (none) 

Explanation 

Explanation/Reference: 

References: 

https://technet.microsoft.com/en-us/library/ee634204(v=sql.105).aspx https://msdn.microsoft.com/en-
us/library/ee634905.aspx 

QUESTION 7 
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Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each 

question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series. 

Start of repeated scenario. 

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A 
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.) 

Data Sample exhibit: 
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.) 
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The tables in the model contain the following data: 

 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or 

revenue are recorded for that day. Total Hours and Total Revenue column. 
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always 

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.  
RepairTypes has a list of all the repair types  Dates has a list of dates from 2015 to 2018 

End of repeated scenario. 

You create a measure named Average Revenue Per Hour that calculates the average revenue per hour. 

You need to populate a cell in a worksheet to display the Average Revenue Per Hour where Repair Type is Engine. 

Which Excel formula should you use? 

A. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, 

“[Dimensions]. [Repair Type]. [Engine]”)) 

B. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, 
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“[Dimensions]. [Repair Type]. [Engine]”)) 

C. =CUBEMEMBER(“ThisWorkbookDataModel”, “[DailyRepairs]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, 

“[RepairTypes]. [Repair Type]. [Engine]”)) 

D. =CUBEVALUE(“ThisWorkbookDataModel”, “[Measures]. [Avg Revenue Per Hour]”, CUBEMEMBER (“ThisWorkbookDataModel”, 

“[RepairTypes]. [Repair Type]. [Engine]”)) 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

References: 

https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0 
https://www.tutorialspoint.com/advanced_excel_functions/advanced_excel_cube_cubemember_function.htm 

QUESTION 8 

HOTSPOT 

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each 

question presents a different goal and answer choices, but the text of the scenario is the same in each question in this series. 

Start of repeated scenario. 

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A 
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.) 

Data Sample exhibit: 
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.) 
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The tables in the model contain the following data: 

 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or 

revenue are recorded for that day. Total Hours and Total Revenue column. 
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always 

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.  
RepairTypes has a list of all the repair types  Dates has a list of dates from 2015 to 2018 

End of repeated scenario. 

To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month. 
For example, if the current date is July 10, 2017, the Value of Months Ago will be 0 for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the 

dates in May 2017. 

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. 

NOTE: Each correct selection is worth one point. 

Hot Area: 
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Correct Answer:  
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Section: (none) 
Explanation 

Explanation/Reference: 

References: https://msdn.microsoft.com/en-

us/library/ee634914.aspx https://msdn.microsoft.com/en-
us/library/ee634567.aspx https://msdn.microsoft.com/en-

us/library/ee634554.aspx 

QUESTION 9 

DRAG DROP 

You have 12 sales reports stored in a folder as CSV files. Each report represents one month of sales data for a year. The reports have the same structure. 

You need to analyze the entire year of sales data. 

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the 
correct order. 

Select and Place:  
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Correct Answer:  

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/


 

Section: (none) 

Explanation 

Explanation/Reference: 
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References: https://powerpivotpro.com/2017/01/import-csv-files-folder-filenames-excel/ https://www.masterdataanalysis.com/ms-excel/import-csv-files-folder-excel/ 
https://support.office.com/en-us/article/create-a-data-model-in-excel-87e7a54c-87dc-488e-9410-5c75dbcb0f7b 

QUESTION 10 

You have the Excel worksheet shown in the exhibit. (Click the Exhibit button.) 

Exhibit:  
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You need to transform the data by using Query Editor. 

What should you do first? 

A. From the Data tab, click Flash Fill 

B. From the Insert tab, click Store 

C. From the Data tab, click From Table/Range 

D. From the Data tab, click Consolidate 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/unified-get-transform-experience-ad78befd-eb1c-4ea7-a55d-79d1d67cf9b3 

QUESTION 11 

You have an Excel workbook that has the following two workbook queries: 

 A query named Consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database 

 A query named Employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database 

Both tables have the same columns. 

You need to combine all the data from Consultants and Employees into one table. 

Which command should you use? 
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A. Append Queries 

B. Combine Binaries 

C. Transpose 
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D. Merge Queries 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/merge-queries-power-query-fd157620-5470-4c0f-b132-7ca2616d17f9 

QUESTION 12 

You have 20 workbook queries that load 20 CSV files to a local computer. 

You plan to send the workbook and the 20 CSV files to several users. The users will store the files in various locations. 

You need to ensure that the users can change the path to the CSV files in the queries as quickly as possible. 

What should you do from Query Editor? 

A. Append all the queries. Edit the source of the first query 

B. Merge all the queries. Edit the source of the first query 

C. For each query, create a new query that uses a reference. Modify the source of each new query 

D. Create a parameter. Modify the source of each query to use the parameter 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://www.howtoexcel.org/power-query/how-to-parameterize-your-power-query/ 

QUESTION 13 

You have multiple workbook queries that load data from tables in Microsoft Azure SQL Database to a Power Pivot data model.  

You discover that new rows were added to the tables in Azure SQL Database. 

You need to ensure that the workbook has the new data. 

What should you do? 
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A. From the Data tab, click Refresh All 

B. From the Power Pivot tab, click Update All 

C. Close and open the workbook 

D. Select a cell in the worksheet and press F5 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-windows-1524175f-777a-48fc-8fc7-c8514b984440 

QUESTION 14 

DRAG DROP 

You merge several CSV files by using Query Editor. 

You need to remove all the leading whitespaces and all the non-printable characters from a column. 

What should you do to achieve each task? To answer, drag the appropriate actions to the correct goals. Each action may be used once, more than once, or not at 
all. You may need to drag the split bar between panes or scroll to view content.  

NOTE: Each correct selection is worth one point. 

Select and Place: 
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Correct Answer:  
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Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 15 

HOTSPOT 

You have a workbook query that uses an Excel data source. The data source contains the following table. 
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You need the data to appear as shown in the following table.  
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How should you transform the data from Query Editor? To answer, select the appropriate options in the answer area. 

NOTE: Each correct selection is worth one point. 

Hot Area: 
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Correct Answer:  
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Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098 

QUESTION 16 

You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the 

data model. You create a PivotTable and a PivotChart. 

You plan to share SalesResult.xlsx to several users outside of your organization. 

You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.  
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What should you do? 

A. Modify the source of the query 

B. Save the workbook as an Excel Binary Workbook (.xlsb) 

C. From Query Editor, open the Data Source and delete the credentials 

D. Run the Document Inspector 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/data-source-settings-power-query-9f24a631-f7eb-4729-88dd-6a4921380ca9 

QUESTION 17 

You have an Excel workbook query that loads data to a worksheet and the data model. 

You need to ensure that the data is refreshed whenever you open the workbook. 

What should you do? 
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A. From the File tab, click Options, and then modify the General options 

B. From the Power Pivot model, modify the Table Behavior setting 

C. From the File tab, click Options, and then modify the Data options 

D. Run the Data tab, click Queries & Connections, and then edit the properties of the query 

Correct Answer: D 

Section: (none) 

Explanation 
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Explanation/Reference: 

References: https://support.office.com/en-us/article/refresh-connected-imported-data-e76a38b0-e2e1-400b-9f2f-c87b9b18c092 QUESTION 18 

You have a workbook query that loads the following table 

 

You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table. 

 

You need to ensure that the data appears as shown in the following table. 
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What should you do? 

A. Change the Aggregate Value Function of the pivot 

B. Change the Data Type of the Value column 

C. Select the ID column, and then click Unpivot Columns 

D. Delete the Pivoted Column step. Select the Key column, and then click Unpivot Columns 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098 

QUESTION 19 

You need to create a PivotChart that has a filter as shown in the following exhibit. 
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What should you do first? 

A. From the model, create a measure 

B. From Query Editor, create a function 

C. From the model, create a hierarchy 

D. From Query Editor, create a parameter 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/measures-in-power-pivot-86484821-a324-4da3-803b-82fd2e5033f4 

QUESTION 20 

DRAG DROP You 
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create a new 
workbook and add a 

table to a data 
model. The data is 

shown in the 
following table. 

 

You need to create a visualization as shown in the following exhibit. 
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Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the 
correct order.  

Select and Place: 
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Correct Answer:  
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Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/create-a-measure-in-power-pivot-d3cc1495-b4e5-48e7-ba98-163022a71198?ui=en-US&rs=en-
US&ad=US https://support.office.com/en-us/article/key-performance-indicators-kpis-in-power-pivot-e653edef-8a21-40e4-9ece-83a6c8c306aa 

QUESTION 21 

You have the following table. 
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You plan to use [Month Name] as the axis in a PivotChart. 

You need to ensure that whenever [Month Name] is used in a chart, the months are displayed chronologically by default.  

What should you do? 

A. Add a calculated column named [ID] that uses the [Month Name]&[Month Number] DAX formula 

B. Change the Data Type of [Month Name] to Date 

C. Sort the [Month Number] column by [Month Name] 

D. Sort the [Month Name] column by [Month Number] 
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Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://gasperkamensek.wordpress.com/2013/04/16/sorting-months-chronologically-and-not-alphabetically-in-a-pivot-table-report-based-on-
powerpivot-data/ 

QUESTION 22 

You have the data model shown in the Data Model exhibit. (Click the Exhibit button.) 

Data Model exhibit:  
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You have the PivotChart shown in the Pivot Chart exhibit. (Click the Exhibit button.) 

Pivot Chart exhibit: 
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You need to change the current view of the PivotChart to display ProductCategory only. 

What should you do? 

A. Right-click a bar in the PivotChart and click Expand Entire Field 

B. Right-click the PivotChart and click Reset to Match Style 

C. Click the + buttonD. Click the – button Correct Answer: A Section: (none) Explanation 

Explanation/Reference: 

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/


References: https://support.office.com/en-us/article/expand-collapse-or-show-details-in-a-pivottable-or-pivotchart-d70d7e70-d230-4d45-81db-1f5e39bcb394 

QUESTION 23 

DRAG DROP 

You have a model that contains the following table named Sales. 

 

You have a measure named TotalSales that calculates the sum of LineTotal. 

You plan to create a PivotChart to display TotalSales for each category and the percent of total sales for each category as shown in the following exhibit. 

 

How should you complete the DAX formula for the Percent measure? To answer, drag the appropriate fields to the correct areas. Each field may be used once, 
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.  

NOTE: Each correct selection is worth one point. 

Select and Place: 
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Correct Answer:  
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Section: (none) 

Explanation 

Explanation/Reference: 

References: https://www.fourmoo.com/2017/07/18/power-bi-dax-measures-for-excel-based-of-column-total-or-of-row-total/ 

QUESTION 24 

You have a table in a Power Pivot model that is loaded from a Microsoft SQL Server database. 

The source table has four columns named ID, Price, Quantity, and Total. Total is derived by multiplying Price and Quantity. ID is a unique row identifier.  

You need to minimize the amount of memory used to load the model. The solution must ensure that you can create visualizations based on Price, Quantity, and 
Total. 

What should you do? 

A. Replace the Total column by using a measure 
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B. Replace the Total column by using a calculated column 

C. From Query Editor, remove duplicate rows from the table 

D. Move the Total column to a lookup table 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/create-a-memory-efficient-data-model-using-excel-and-the-power-pivot-add-in-951c73a9-21c4-46ab-

9f5e14a2833b6a70#__toc373850959 

QUESTION 25 

You add two tables named Date and Invoices to a data model. Invoices contains a column named InvoiceDate that has a data Type of Date. Date contains a 
column named DateID that has a Data Type of Whole Number. DateID is in the format of YYYYMMDD. 

You need to create a relationship between Date and Invoices. 

What should you do first? 

A. Change the Data Type of InvoiceDate and DateID to Text 

B. Create a calculated column in Invoices that uses the FORMAT DAX function 

C. Change the Data Type of DateID to Date 

D. Create a measure in Invoices that uses the FORMAT DAX function 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

References: https://support.office.com/en-us/article/data-types-in-data-models-e2388f62-6122-4e2b-bcad-053e3da9ba90?ui=en-

US&rs=enUS&ad=US#__toc319430522 

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/


 

   https://vceplus.com/ 

www.vceplus.com - Download A+ VCE (latest) free Open VCE Exams - VCE to PDF Converter - VCE Exam Simulator - VCE Online

https://vceplus.com/
https://vceplus.com/
https://vceplus.com/

